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1. Monitor Components

1.1. Series 200 and 300 Monitors

The following components are supplied with the Series 200 and 300 Monitor:
¢ Monitor base

e Sensor head

e 12 VDC AC/DC adaptor or Lithium Smart Charger

e Battery pack — 9.6V Ni-MH or 11.1V Lithium Polymer

e Optional — Temperature and relative humidity sensor

1.2. Series 500 Monitor

The following components are supplied with the Series 500 Monitor:
¢ Monitor base

e Sensor head

e USB to monitor cable

e Lithium Smart Charger

e Battery pack — 11.1V Lithium Polymer

e Optional — Temperature and relative humidity sensor and two-way adapter cable

Note 1: The data logging software for the Series 500 can be found at:

http://www.19mro.com

Please check that all these components have been supplied and contact your distributor or Aeroqual
at: sales@aeroqual.comif any of the components are missing.

Replacement batteries, sensor heads and other accessories can be purchased separately.

aeroQuAL

Portable Environmental Monitor

)

MADE I¥ MEW ZEALAND wewssesqualoom |
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2. Installation

The following actions need to be completed before the monitor is ready for use:
o Insert the sensor head into the top of the monitor. The sensor head is keyed to ensure
the head is inserted correctly.
e The battery must be connected and charged prior to use. The battery is shipped installed
in the monitor but disconnected.

e The temperature and RH sensor needs to be inserted — optional

2.1. Battery Pack

2.1.1. Installation

1. Remove the battery cover and battery pack from the monitor

2. Insert the battery power connector

3. Put the tail end of the battery pack into the hinge points at the bottom of the monitor and clip
the top end of the battery pack into the top clips

4. Replace the battery cover on the monitor

2.1.2. Removal

1. Remove the battery cover from the monitor

2. Insert your thumb under the top left hand side of the battery pack and carefully lever the
battery pack out from the retaining clips

3. Unclip the connector from the monitor and remove

2.1.3. Charging Ni-MH Batteries

The life of the battery will be affected by the way it is handled. Take good care of the battery pack and
follow the guideline below.

Ni-MH batteries must be fully charged prior to first-time use. A new Ni-MH battery's full performance is
achieved only after a number of complete charge and discharge cycles. A fully charged battery will
run for approximately 4-6 hours depending on the sensor head being used.
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With the adaptor plugged in and unit turned on allow 15 hours for the battery to fully
charge.
e During charging the battery symbol on the display flashes slowly
e The battery can be charged with the sensor head installed or removed from the base.
(Remember to switch off the monitor before removing the sensor head)
e Unplugging the main power will reset the above charging conditions
e The batteries can be charged and discharged many times but will eventually wear out
When the operating time is noticeably shorter than normal, it is time to replace the battery
e ltis not necessary to fully discharge the battery. When not using the monitor as a portable
unit, always plug in the mains adaptor to recharge the battery

o Ifleft unused a fully charged battery will discharge itself over time

2.1.4. Charging Lithium Polymer Batteries

A new battery's full performance is achieved only after a number of complete charge and discharge
cycles. A fully charged battery will run for approximately 8 hours depending on the sensor head

being used. Perform charging at temperatures between 0 °C to 45 °C.

With the adaptor plugged in and unit turned off allow 3 hours for the battery to fully charge.
o  Lithium versions show “Lithium Battery” on the initial monitor start up screen.
e The battery can be charged with the sensor head installed or removed from the base.
(Remember to switch off the monitor before removing the sensor head).
e The Lithium Smart Charger displays a red LED light when charging and a green LED
light when the battery is charged when monitor is off.

Note: The unit can be charged when switched on but it will charge more slowly. When the

unit is operating the red LED will remain on, even if the battery is fully changed.

2.1.5. Safety Information
e Do not use the battery pack for any other purpose than operating the Aeroqual monitor
e Do not disassemble or deface the batteries as this may cause burns

e Do notincinerate or heat as this may cause burns, the batteries may burst or cause the

release of toxic materials
e Do not short circuit as this may cause burns

e Use only batteries approved by Aeroqual and recharge your battery only with the AC/DC
adaptor supplied with the instrument.

e Never use any charger or battery that is damaged or worn out

e Batteries must be recycled or disposed of properly. They must not be disposed of in municipal
waste

e Never charge the battery in a hermitically sealed container
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2.2. Sensor Heads

2.2.1. Sensor Warm Up
Prior to operation the sensor must be warmed up to burn off any contaminants. When the monitor is
first switched on it will warm up for 3 minutes. The reading will then flash for the next 7 minutes to
indicate that the sensor is still in the warm up phase. It is recommended that the monitor is kept in
Stand By mode when not being used to keep the sensor heated and prevent the build-up of
contaminants. If the sensor is new (or unused for long periods) it can take up to 24 hours for the
message “sensor warming up” (or “sensor failure” in older models) to disappear. Should the message
remain after this time, a genuine sensor failure may have occurred. See the trouble-shooting guide.
For Ozone Sensor Heads:
e 24hours is a conservative time for an ozone sensor to burn off contaminants and achieve its
stated performance specification. In most instances this will be achieved well within 24hrs.
e The warm up period can be reduced by subjecting the sensor to elevated ozone levels for a
short period. For example, 0.1 ppm of ozone for 5 minutes typically reduces the warm up time

to <30 minutes.

Note: Do not remove the sensor head while the monitor is switched on. This may damage the
unit. If the sensor head is removed under these conditions without AC/DC adapter connected,

the unit will automatically shut down.

2.2.2. Sensor Head Failure
There are three possible sensor failure modes, which will be indicated by one of the following

messages on the display:

“Sensor Failure, Replace sensor” - The sensor head should be replaced as this indicates that there

has been component failure.

“Sensor aging”-This indicates that the sensor has reached the end of its usable life and the sensor
head should be replaced as soon as possible. The measurement readings can no longer be relied
upon to be within specification.

Note: This message will only apply for O3 Low/Ultra Low sensor heads.

“S.F.” — When there is more than one sensor connected, S.F. will show for a sensor failure condition.

2.3. Optional Temperature and Relative Humidity Sensor

If the temperature and relative humidity sensor has been purchased, it can be inserted into the PS/2
connector at the base of the monitor. Ensure monitor is turned off before connecting the sensor.
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Two Way
Adaptor Cable

Temperature &
Relative
Humidity Sensor

USB to Monitor
Cable

Note: The monitor will still operate with only the temperature

and RH sensor connected.

3. Operation

The following instructions detail the operation and set up of the monitor:

3.1. Series 200 Display

. QEeroQUAL

Power button / R
Scroll button el

Sertes 200

3.2. Series 300 & 500 Display

\

Power button —l QeroQuUAL |<— Enter

<+— Scroll up

4— Scroll down

Series 300 )

Alarm mute —»
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3.3. Powering On and Off

To turn the monitor on: Press and hold the power button until the screen activates. The monitor will
turn on and the display will show AEROQUAL MONITOR and the Series Version and Firmware
Version. If the monitor is configured for use with a Lithium battery, it will also say “Lithium Battery”.
After 5 seconds the display will change to indicate the type of sensor head.

The monitor will then warm up. Once warm up is complete the main display will appear as seen

below:
03 ULOW 03 UL0.080
or TEMP 21.6C
0. 080 RH 35.1%
M 02 o m
L 03 ppm :\_Agi w P

e A battery indicator will appear at the bottom of the display when the monitor is operating
under Ni-MH battery power only. The indicator shows the battery life remaining

e The M and L (Monitor and Location) will only show on the Series 300 and 500

e If a multi sensor is being used the screen will scroll through the parameters showing each
reading, only 3 parameters can be shown on the screen at one time

To turn the monitor off: Press and hold the power button for 2 seconds until the monitor beeps.

The display will now be blank and operation of the monitor will cease.

To activate standby mode: With the monitor on, press the power button once. This will stop

operation of the monitor; however the sensor will be kept warm.

This mode is used to conserve power between operations but keep the sensor ready to measure the
gas concentration with only a short warm up phase needed. In this mode the display will show the
sensor type and standby symbol.

To return the monitor to operational mode press the power button once.

Note 2: When using a Carbon Dioxide sensor head in standby mode, the sensor runs at full
power and the fan remains on.

3.4. Menu Functions

To enter the set up menu press the enter button on the display. The following menu will appear
depending on the Series of handheld:
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Series 200 Series 300 Series 500
EXIT EXIT EXIT
ZERO CAL LOCATION ID LOCATION ID
UNITS MAX MIN AV MAX MIN AV
MIN MAX AV CALIBRATE CALIBRATE
MUTE KEY MONITOR SET UP MONITOR SETUP
_— LOGGING SETUP
EXIT
EXIT \ v
MONITOR ID MONITOR ID
UNITS UNITS
OUTPUT SENSOR OUTPUT SENSOR
ALARM POINTS
ALARM POINTS
CONTROL POINTS
CONTROL POINTS MUTE KEY
MUTE KEY
CLOCK SETUP
3.4.1. Units

e To enter, scroll down in the set up menu and select “{UNITS”. (Found under “MONITOR
SETUP” in the Series 300 and 500)

e Choose between ppm or mg/m3 via the scroll button and press enter to confirm the unit
selection

o If there is a temperature and humidity sensor attached there is the option to choose from
either °C or °F

3.4.2. Max/Min/Average Measurement Cycle

e To enter, scroll down in the set up menu and select “MAX MIN AV”

e Select “start” to initiate the measurement cycle and return to the setup menu
e Scroll to “EXIT” to return to the main display

e The readings will scroll along the screen

Note: Only three parameters will be shown on the screen at one time.

e Inthe Series 300 and 500 the “MAX MIN AV” cycle can also be initiated from the main display
by holding down the “scroll down” button for 2 seconds until the unit beeps. Hold down the
“scroll down” button again for 2 seconds to stop the measurement cycle.

¢  When the “MAX MIN AV” cycle is initiated, the display should read as seen below:

O3 UL O3 UL TEMP RH

PPM PPM C %
RD 0.010 or RD 0.010 23 50
MIN 0.005 MIN 0.005 22 50
MAX 0.024 MAX 0.024 25 56
AVE 0.015 AVE 0.015 24 54
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Note 1: The MIN, MAX and AVE readings are the minimum, maximum and average readings
over the period from the start of the cycle.

Note 2: The RD value is the current reading.

Note 3: The speed of the display scrolling is dictated by the slowest sensor. The display will
scroll every time a new set of readings have been taken.

3.4.3. Calibration

To enter, scroll down in the set up menu and select either “ZERO CAL” on the Series 200 or
“CALIBRATE” on the Series 300 and 500. To enter the calibrate menu the “mute” and “scroll
down” button needs to be held down for 2 seconds. From here either “ZERO CAL” or “SPAN

CAL” can be selected.

For more information on how to calibrate the sensor heads please refer to Section 6 of the User
Guide.

3.4.4. Mute Key

e To mute the audible feedback “beeps” that occur when you press a button, scroll down in the
set up menu and select “MUTE KEY”. (Found under “MONITOR SETUP” in the Series 300
and 500)

e Press the enter key to silence the audible feedback “beeps”, the word muted will appear next
to MUTE KEY

e On the Series 200, if the device is turned off the mute settings will be returned to the default
state and will have to be reset when the monitor is restarted

3.4.5. Location ID (Series 300 & 500)

e To select the location ID, scroll down in the set up menu and select “LOCATION ID”

e The location ID provides a means of identifying the location where a measurement was taken.
This can be used to quickly trace a measurement back to a location

e Location ID is logged for each measurement

e Press “enter” to confirm the ID and return to the set up menu

3.4.6. Monitor ID (Series 300 & 500)

e The monitor ID can be found under “MONITOR SETUP”, scroll down in the monitor set up
menu and select “MONITOR ID”

e Each monitor can be numbered to identify them quickly when more than one is in use
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e Data is tagged with the monitor ID at the time it is downloaded to the PC, so you can use
more than one monitor with a single instance of PC software (S500 only). Each record in the
database contains date/time, monitor id, location id, sensor type, sensor reading.

e For compatibility purposes the database records for earlier versions of the S500 (v5.x) default
to monitor ID = 1 and location ID = 1. This cannot be changed.

e Press “enter” to confirm the ID and return to the set up menu

Note: In the Series 500 data logging mode only the Location ID will be logged. The monitor ID

is loaded to the database at the time of data upload (where it is logged).

3.4.7. Output Sensor (Series 300 & 500)

¢ If a multi-sensor head is connected, the output sensor selection will determine which sensor
the alarm and control points and buzzer refer to

e The output sensor can be found under “MONITOR SETUP”, scroll down in the monitor set up
menu and select “OUTPUT SENSOR” and select the relevant parameter

e The 0-5v analogue signal will also operate on the selected sensor and measurement range

3.4.8. Alarm Points (Series 300 & 500)

e The alarm points can be found under “MONITOR SETUP”, scroll down in the monitor set up
menu and select “ALARM POINTS”

e Once the alarm set up menu has been entered “ALARM HI” will display

e Press the “scroll up” and “scroll down” buttons to select the correct concentration

e Press “enter” to confirm the change

e Once the high alarm has been set “ALARM LO” will display

e Press the “scroll up” and “scroll down” buttons to select the correct concentration

e Press “enter” to confirm the change

Once the low alarm has been set “BUZZER” display will show. Here you can either enable or disable
the alarm. If the alarm is disabled a “P” will show on the right hand side of the alarm mute symbol on
the main display, highlighting that the alarm has been permanently muted.

¢ If the concentration reaches above the high alarm point two flashing arrow symbols pointing
upwards will appear on the display, accompanied by a fast beeping sound.

¢ If the concentration reaches above the low alarm point two flashing arrow symbols pointing
downwards will appear on the display, accompanied by a slow beeping sound.

Note: The alarm can be muted by pressing the mute button on the display screen. However,

this is only a temporary mute and will only mute the alarm during that specific alarm condition.
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Once the concentration has moved back into the alarm limits the settings will reset. To turn of

the mute permanently follow instructions to disable the alarm.

3.4.9. Control Points (Series 300 & 500)

e The control points can be found under “MONITOR SETUP”, scroll down in the monitor set up
menu and select “CONTROL POINTS”

e Once the control points set up menu has been entered “CONTROL HI” will display

e Press the “scroll up” and “scroll down” buttons to select the correct concentration

e Press “enter” to confirm the change

e Once the high point has been set “CONTROL LO” will display

e Press the “scroll up” and “scroll down” buttons to select the correct concentration

e Press “enter” to confirm the change

3.4.10. Clock Setup (Series 500)

e The clock setup can be found under “MONITOR SETUP”, scroll down in the monitor set up
menu and select “CLOCK SETUP”

e To change the hours press the “scroll up” and “scroll down” buttons until correct time is
recorded

e Press “enter” to confirm and adjust the minutes using the “scroll up” and “scroll down” buttons.

e Repeat to adjust the seconds, month, day and year.

Note: The clock is a 24 hour clock

14:30:12 Hours: Minutes: Seconds
Oct 07 12 Month: Day: Year

3.411. Logging Setup (Series 500)

e To enter, scroll down in the set up menu and select “LOGGING SETUP”
e The log frequency will appear on the display.

e Adjust the frequency by using the “scroll up” and “scroll down” buttons

Note 1: The frequency is set to 1 minute intervals

e Once the frequency is set, press the “enter” button to confirm.

e The option to clear the log will then display on the screen.

e Press the “scroll up” button to select either YES or NO and press “enter” to confirm the
selection.
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Note 2: The data log can also be cleared directly from the main display screen by holding
down the mute button for 2 seconds until the monitor beeps (if the monitor keys are not

muted).
e The display will then give the option to start logging

e Press the “scroll up” button to select either ON or OFF and press “enter” to confirm the

selection and return to the main menu.

LOG FREQ. CLEAR LOG LOGGING

1 MIN YES NO ON OFF

Note 3: Data logging can also be both started and stopped directly from the main display
screen by pressing the “scroll up” button for two seconds until the monitor beeps (if the

monitor keys are not muted).

When data logging is initiated a triangle will appear on the main display screen.

The triangle is an indication that data logging is active, and is also used as an indication of the
presence of data, as described below:
e An empty triangle indicates that no data is stored
o Afilling triangle indicates that some data is stored in the memory. The triangle will fill up in
10% increments.

e A full triangle indicates that the memory is full and needs downloading to the PC.

4. Aeroqual Monitor Software (Series 500)
41. SetUp

Computer Requirements
e USB to monitor cable
e Window OS version 2000 or later
e Recommended 512 Mb RAM or more

e Recommended 1 GHz processor speed or faster

Note: S500 V6.0 software will support back to S500 V5.x, earlier versions are incompatible

4.1.1. Connect

1. Connect the Series 500 monitor to a computer using the cable supplied and turn on
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2. Launch the Aeroqual Monitor PC software and click H on the toolbar to search for the
monitor. The unit will be detected automatically and connect

3. Test the connection by clicking ﬂ" on the tool bar. This will display the Monitor Name,
Version and ID Number

4.1.2. Configuration

The Software can be used to set up the Monitor ID, Location Id, Alarm and Control Limits,
Logging Frequency, Units of Measurement, Output Sensor and Updating the Clock.

e Click Monitor - Setup (or Ctrl P)
o The monitor setup dialog box will appear

e Type in the required values or scroll up or down to
set the desired values.

e Click the save button to synchronise the monitor
values with those on the PC.

e |n order to data log it is essential that the clock on the
monitor is set to the real time. This can be done on

10003

the monitor (Section 4.4.6.) or via the PC by using ; Ry
the “Update Clock” button in the configuration menu. 7] Set Alarm Pesmanent Mute
W Sethmy muts
Note: If the temperature and humidity sensor is
Conlbral Setbnga
connected an option to select temperature unit will Conrel High

appear

4.2. Data Logging

The Series 500 monitor can log up to 8188 data points divided by the number of sensors being
logged. For example, if a triple sensor is connected it will log 8188/3 readings. Each sensor uses one
of the records each log period. Refer to Section 3.4.11 for instructions on how to log data on the
monitor itself. Alternatively, data can be logged directly to a PC.

4.2.1. PC Data Logging

Ensure that the USB cable is connected to the monitor and to the PC. Click File > Start PC Data
Logging or click on the toolbar. The data will be logged directly to the database on the PC. No
data will be stored on the monitor memory in this mode of operation. However, if PC data logging is
stopped by clicking $ on the toolbar the data will start to be stored in the Series 500 monitor

memory.
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4.2.2. Downloading Logged Data from Series 500

Logged data from the monitor memory can be downloaded by clicking File > Download Logged Data
or by clicking & on the toolbar.

A data download progress bar will appear while the data is downloading. Once that data download to
the PC is complete, the monitor will beep and ask the user whether they wish to clear the logged data
on the monitor. Data logged on the monitor must always be cleared manually otherwise the data from
the monitor's memory will be duplicated in the database each time a data download is performed.

If for any reason, the data download does not complete, is terminated or stops:
e Turn off the monitor to prevent any data loss.
e Delete the data that has been downloaded to the PC

e Close the PC software program and repeat the downloading process with the monitor on,

connected and with the PC software running.
4.2.3. Graphs

While logging directly to a PC, the Real Time View Graph or the Logged Data Graph can be

accessed via the “Data” menu on the menu bar.

Note: If a multi sensor is plugged in each parameter will been shown in individual tabs

1. The graphs can be configured by clicking Data > Graph - Default Style or by right clicking
on the graph and selecting “Graph Style”

2. Right click on the graphs to save or print the graphs
o  Graphs will be saved as a JPG file
To reset the graph to the default, right click and select “Reset to Default”

The logged data graph can be viewed be clicking Data - Graph - Logged Data

I Real Time Graph View B2

Note 1: In the Logged Data Graph the date, time |<lcoz[eo

and sensor type to be viewed can be selected. The

co

10000

Monitor and Location ID can also be selected.

gooofl

Note 2: The Monitor ID is not logged on each
record in the monitor but will be stored in the

s0.00f

ppm

database against each measurement when the data

4000

is downloaded. The data will be tagged with
whatever the monitor ID is at the time of download.

1000

Conversely, the location ID is logged on each

L L L L L L L L
14:00 15:00 18:00 17:00 18:00 12:00 20:00 2100 2200

record in the monitor.

Min: 0 ppm Mazx: 0 ppm Ave: 0 ppm
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4.2.4. Tables

While logging directly to a PC, the Real Time Table View or Logged Data Table can be accessed via
the “Data” menu on the menu bar.

[ Real Time Table View [o [E &  |loggedData Table View [ e
Table View Settings
Index DateTime  Monitor ID Location ID CO(ppm) CO2(ppm) PID{ppm) From: Mornitor Functions
1[29 Nov 201... 2 5 0.00 127 045 |01-Nov-2012 E 15:23}%] Menitor ID |2
228 Nov 201, 2 5 0.00 53 0.45 S - .
3[28 Nov 201... 2| 5 0.00 110 0.45 To: LocationID |5 -
4[23 Now 201... 2 5 0.00 106 0.45 i : = —
5[28 Now 201... 2 5 0.00 116, 0‘4;| |28 timaniz E 15:2305] Sensors:  |CO2 - L -
6[29 Nov 201... 2 5 0.00 111 MEI :
7[28 Now 201.... 2 5 0.00 128 0.45
829 Nov 201... 2| 5 0.00 130 u‘qil s
2129 Nov 201... 2 5 0.00 3] 0.45 Index Date Time Monitor 1D Location 1D co2(ppm)
10(29 Nov 201... 2| 5| 0.00 138 0.45
—|_1129 Mo 21 2 < o0 8 e 1 9Nov 121224 |2 5 243 -
1228 Now 201... 2 5 0.00 117 0.45 £l H e, 2 2 Lo
13[28 Now 201. 2 5 0.00 119 0.45 & N M2ATx, B = 20 5
1328 Now 201... 7 5 0.00 114 0.45 it coudhun e 2 i i
5 BNov 0121228 |7 5 23
3 BNovZD121231 |7 5 252
7 WNovaD121232__ |2 5 a7
8 WNovaD121233 |7 5 3
3 BNovaD121234 |7 5 235
0 Nov 20121235 |7 5 238
i1 B Nov 20121236 |2 5 22
2 BNov 0121237 |2 5 24
3 BNovZD121238__ |7 5 199
14 BNov 0121239 |7 5 186
15 B Nov 2012 1240 |2 5 203
6 NovZD12 1241 |7 5 235
17 BNovaD1212:42 |7 5 218
8 SNov 0121243 |7 5 210 -
[ Export | [ Delete | [ lose |

In the logged data table view the date, time and sensor type can be selected to view the relevant
data. The Monitor and Location ID can also be selected. Clicking “view all” does not use the filter and
will show all the parameters and data in the database. Alternatively, clicking “apply” will filter the

parameters and show the chosen data.

1. To export the data, click the “Export” button on the logged table view.
e Select a directory and choose a file format (either plain text or MS Excel file) and enter a
file name. Click “Save” to export the data.
2. The data can be deleted by clicking the “Delete” button on the logged data table view.

e This will delete the individual data points shown in the logged data table from the
database.

4.2.5. Data Analysis

The Daily View is a summary for each day, from midnight to midnight, of the Minimum, Maximum and
Average readings over the 24 hour period.

o C(Click Data - Daily Analysis to launch the Daily View window

e Either select the date range, monitor and location ID and click “Apply” or click “View All" to
show the daily analysis.

The summary data files can be exported to programs such as MS Excel by clicking the “Export”
button.

To delete the summary data click the “Delete” button. This will not delete the individual data points
from the database, only the daily summary data.
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= Daily View FEEEE
View Settings
From: Monitor Functions.
|30-Nov-2012 [oo]  Monitor (a1 v
To: Location ID AII v )
;9?—Dec—zﬂ 12 m Sensors: | Al
Daily Data
Index Date Manitar ID LocationID  Sensor Ma... Min Max Ave
1| Wed, 05 Dec 2012| 10 503 ULOW (.. 0.11f 0.11f 0.11f
2| Wed, 05 Dec 2012| 10 8(CO (ppm) 0.36 0.36 0.36
3| Wed, 05 Dec 2012| 10 8(CO2 {ppm) 181.30 284,30 218.92
4| Wed, 05 Dec 2012| 10 B{PID {ppm) 115 1.15| 1.15]
5| Wed, 05 Dec 2012| 10 BRH (%) 68,11 73.02 70,93
6| Wed, 05 Dec 2012| 10 B[TEMP (C) 22,50 25.09 23.56
7| Thu, 06 Dec 2012| 10 3(CO (ppm) 0.36 0.36 0.38
8| Thu, 06 Dec 2012| 10 8|COZ {ppm) 172.30 590.30 264.95)
9| Thu, 06 Dec 2012| 10 8PID (ppm) 1.13] 1.15] 1.15
10| Thu, 06 Dec 2012| 10 BRH (%) 58.03 75.52] 69.94
11| Thu, 06 Dec 2012| 10 B[TEMP (C) 21.66] 27.72 23.52]
Export ] I Delete ] I Close 1

4.3. Advanced Data Management

1. To archive logged data, click File > Zip Database
e Select a directory and input a file name to backup all the current stored data to a zipped
file
2. Toview archived logged data, Click File > Unzip Database
e Select the zipped file and click OK.
e View and analyse data as required (Data > Table ->Logged)

Note: To view an archived database it is important that any existing data logging function is
not interrupted. Do not view archived data on the same PC being used for data logging; the
current data in the database will be lost unless it has been zipped.

5. External Control Wiring (Series 300 & 500)

The pin numbers for the external output connector are numbered from 1 to 6. Pin 1 is the closest pin
to the power jack.
The pin designations are as follows:
1. 12V DC
Analogue output 0-5V
Control
High alarm
Low alarm

2 T

Ground
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The RJ12 connector offers two possibilities for wiring, either a switch to GND or a 12V output. If the
12V output is used, the power for the relay coil is supplied by the Aeroqual AC/DC adaptor. In this
case, ensure that the relay coil does not draw more than 150mA and that a protection diode is

inserted across the relay coil.
If the switch to GND output is used, ensure that the relay coil does not draw more than 150mA, that

the voltage does not exceed 24V and that a protection diode is inserted across the relay coil.

5.1. Wiring for Alarm

The high alarm and low alarm pins can be wired to supply simple on / off switching to operate

equipment which requires only an on or off signal, such as an alarm.

To switch to GND use pins 4, 5 and 6. For a 12V output wire to pins 4, 5 and 1 (see the following
diagram for typical wiring for high alarm). This feature will only operate while powered by the AC

adaptor.

High gas level alarm

AC RELAY

1.5 . +12V Mom. from Plug F'Eckl : BEL SUPPLY
20— W
= hzicon |, "\ BELL ETC
4 jsoma mae |
s | | | i
6— {1
i MINIATURE RELAY
RJi2

Note: Failure to insert a circuit protection diode, shown as above, will result in damage to the

monitor if a voltage spike is created by the relay.

5.2. Wiring for Control

The control pin can be wired to supply control of a gas concentration between upper and lower
concentration limits. The upper and lower limits can be set by the user. The factory default settings

are dependent on the gas sensor head selected at time of purchase.

To switch to GND use pins 3 and 6. For a 12V output wire to pins 3 and 1 (see following diagram for

typical wiring). This feature will only operate while powered by the AC adaptor.

Control is achieved by using a software latch. If power is lost to the monitor, the switch will open and
therefore turn off the external device connected to the monitor external output. The following wiring
diagram demonstrates the typical wiring to achieve the required control.
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o

I +12V Mom. -from Pluepack

2= TV OO CONTROL CIRCUTT

i _' 150ma e | "'

i ] |

6 — - &
=2 MINIATURE RELAY

Note: Failure to insert a circuit protection diode, shown as above, will result in damage to the
monitor if a voltage spike is created by the relay.

5.3. Wiring the 0-5 V Analogue Output

The 0 to 5 V signal is a proportional signal based on the measurement of the selected output sensor.
The voltage out spans the specified gas sensor concentration range. For example: With the low
concentration ozone sensor head: 0 V represents 0 ppm ozone and 5 V represents 0.500 ppm ozone.
Note: The ultra-low ozone sensor is a special case — 1.5V represents 0.150ppm ozone in this
case.

Note: Wire between pins 2 & 6

See Section 7.1 for output status conditions.

6. Calibration of Sensor Heads

Sensor heads can be calibrated in two ways:
1. Via replacement. Return your sensor head to Aeroqual and purchase a refurbished sensor
with a multi-point calibration and new calibration certificate.

2. Manual calibration. The easy calibration procedure is outlined below. Aeroqual supplies a
calibration humidifier accessory (R42) to facilitate humidity control and delivery of calibration
gas to the sensor head.

6.1. Calibration Procedure

In order to calibrate successfully the following equipment is needed:
e RA42 Calibration Gas Humidifier
o Teflon tubing (Regulator to gas inlet)
e 0.5 LPM constant flow regulator (eg Calgaz regulator model 715, flow rate 0.5 LPM)
e Span gas in air cylinder

e Zero grade air cylinder
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1. Charge R42 Calibration Gas Humidifier with 5g of water with water syringe via water inlet.
2. Fit cylinder and regulator to R42 gas inlet via Teflon tubing and Luer attachment.

3. Place warmed up Aeroqual sensor head in R42 outlet as shown below. The Aeroqual sensor

head is now ready for zero or span calibration.

6.2. Zero Calibration

Under some circumstances the sensors may temporarily exhibit a baseline reading higher than zero
due to insufficient warm up or cross-sensitivity to other gases. In this case it is also worthwhile
checking against a standard zero air source.

1. Follow the initial set up instructions in 6.1
2. Flow zero air until the reading stabilises (about 10 minutes)
3. Initiate Zero Calibration on the Aeroqual Monitor by:

e Series 200: Press and hold the “enter” button until the word “Zeroing” appears next to
ZERO CAL. The routine will run for up to ten minutes (depending on the gas sensor
installed) and then beep to indicate completion.

e Series 300 and 500: : Enter the CALIBRATE menu by pressing the “mute” and “scroll
down” buttons for 2 seconds. From here select “ZERO CAL” then:

o Single gas heads: Toggle YES/NO using scroll button to YES then press enter.
The word “Zeroing” appears and the zero routine will run for up to ten minutes
(depending on the gas sensor installed) and then beep to indicate completion.

o Multi-gas sensor heads and T/RH probe: Press enter to bring up the OFFSET
for the Sensor head. Use the scroll buttons to change the OFFSET and enter
button to accept. Calculate the new OFFSET using the equation below:

New OFFSET = Sensor Reading/GAIN + old OFFSET

Note 1: The Series 200 can only zero calibrate single gas sensors.
Note 2: Temp/RH offsets are stored on the handheld rather than on the sensor. All other

offsets are stored on the sensors.
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6.3. Span Calibration

Span calibration is only available on the Series 300 and 500. It provides an option to adjust the GAIN

of Aeroqual sensor heads.

Recommended span concentrations for some Aeroqual sensor heads is given in the table below:

Aeroqual Sensor Head Recommem!ed .sparl cal gas
concentration in air (ppm)
Carbon Monoxide 0-100 ppm 100
Carbon Monoxide 0-1000 ppm (leak) 1000
Carbon Dioxide 0-2000 ppm 1000
Carbon Dioxide 0-5000 ppm 1000
Nitrogen Dioxide 0-1 ppm 0.5
NH3 0-100ppm 50
NH3 0-1000ppm (leak) 500
Hydrogen 0-5000 ppm 5000
H,S 0-10 ppm 10
H,S 0-50 ppm 50
Methane 0-10000 ppm 5000
Ozone (low or ultralow) 0.1
PERC 0-200 ppm 50
SO, 0-10 ppm 10
SO, 0-100 ppm 100
VOC (Isobutylene) 0-500 ppm 100
VOC (NMHC) 0-25 ppm 25

1. Follow the initial set up instructions in section 6.1
2. Flow the target gas at 0.5 LPM
3. Measure the gas concentration on the monitor screen and wait for it to stabilise (10 minutes).

4. |If the Aeroqual sensor head requires a span adjustment then enter the CALIBRATE menu by
pressing the “mute” and “scroll down” buttons simultaneously for 2 seconds. Then select
SPAN CAL and change the GAIN using the scroll buttons. Calculate the new GAIN using the

equation below:

New GAIN = Old GAIN x Span Gas Concentration (ppm) / Sensor Reading

Note 1: Temp/RH GAINs are stored on the handheld rather than on sensor. All other GAINs are

stored on the sensors.
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7. Specifications

The Aeroqual handheld monitors have been specifically designed to incorporate Aeroqual’s in-depth
knowledge of accurate ambient gas measurement and can be used with a wide range of gas sensor

heads. The sensor heads are interchangeable and therefore multiple heads can be used on the same

base unit. The sensors are calibrated prior to delivery.

Gas measurement units

ppm or mg/m3

Reading functions

Minimum, maximum, average

Sensor head

Interchangeable, replaceable, refurbishable

Display type

LCD

Display status indicators

Battery, sensor, standby, mute, high/low alarm,
monitor ID, location ID.

Sensor calibration features (S300 S500)

Zero and span via secret menu

Power supply

12V DC (power adaptor/charger supplied 100-
250V AC)

Rechargeable battery

Ni-MH 9.6V DC | 2100mA/h or Lithium 11.1V

Temperature & Humidity sensor

Temp: -40°C to 124°C; RH: 0 to 100%

Size (with sensor head)

195 x 122 x 54 (mm)

Weight (with sensor head and battery)

<460g

Environmental operating conditions

Temperature: -5 °C to 45 °C
Humidity: 0 to 95% non-condensating

Enclosure material and rating

PC and ABS; IP20 and NEMA 1 equivalent

Audible Alarm (S300 & S500)

Low alarm, high alarm

External transistor outputs for alarms &
control (S300 & S500)*

12 VDC or switch to GND (150 mA max)

Analogue output (S300 & S500)

0-5vV

Digital interface (S500)

RS232 with USB converter

Data logging capacity (S500)

8188 data points in total

PC data logging (S500)

Software and data cable supplied

Clock function (S500)

Real time

Approvals

Part 15 of FCC Rules
EN 50082-1: 1997
EN 50081-1: 1992

Fe Ce€C

*All of the transistor outputs are open collector current sink. The maximum rating of these transistor
outputs is 12VDC at 150mA. Should you connect a relay or any other inductive load to the transistor
outputs, a back EMF suppression diode must be fitted across the load.

Aeroqual accepts no responsibility for damage to this product or any other issues arising from the
non-compliance with the above directives. Failure to implement these directives will invalidate the

warranty on this product.
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7.1. Diagrams
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Fault Description

Possible cause

Remedy

No power

Lead connection broken
Power supply failure
Battery flat

Unit damaged

Sensor head damaged

Reconnect power lead

Replace 12V DC power supply
Recharge battery

Replace unit

Replace sensor head

Sensor failure when
the sensor is new

Insufficient warm up

Air contaminated

Sensor damaged

Run the sensor on full power for 24-48
hours. If an O3 source is available,
exposure to 100 ppb for 5 minutes will
speed up the decontamination process
(approximately 30 minutes)

Move the sensor to cleaner environment
and check reading

Replace sensor

Reading high under
zero gas conditions

Background gas level higher
than normal
Interfering gas present

Sensor zero drift

Sensor damaged

Move sensor to clean air and
check reading is zero or close to zero

Move sensor to clean air and
check reading is zero or close to zero

ZERO CAL sensor zero grade air using
R42

Replace sensor

Reading higher than
expected in the presence of
sensor gas

Sensor correct

Interfering gas present

Sensor calibration lost

Check calibration of gas generator.

Move sensor to clean air and check
reading upon exposure to known gas
concentration

Replace /refurbish sensor

Reading lower than expected
reading in the presence of
sensor gas

Sensor correct

Sensor inlet contaminated

Sensor fan failed

Check calibration of gas generator

Clean sensor inlet filter and mesh

Replace sensor
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Interfering gas present

Gas reactive and de-composing
before detection

Local air flow too high (ozone
sensors) or too low (VOC and
ammonia sensors)

Sensor calibration lost

JdelOQUAL

Move sensor to clean air and check
reading upon exposure to known gas
concentration

Move the monitor closer to them source
of the gas

Modify the airflow into and around
sensor head.

Replace /refurbish sensor

Reading unstable

Power supply unstable

Power supply current rating
incorrect

Local air flow too high

Environmental conditions
fluctuating

EMI noise picked up via USB
cable and PC (S500 unit only)

Install stable power supply

Install power supply with correct
rating

Reduce air flow
Reduce fluctuations
Unplug cable to determine if this

reduces the instability. If this solves the
problem then isolate the power on PC

External alarm and control
doesn't work correctly (Series
300 and 500 units only)

Incorrect RJ12 pins used

No diode across external relay
coil

Diode polarity incorrect

Check pins and wire correctly

Fit diode across external relay coil

Fit diode correctly

USB communications unstable
(S500 only)

Connections broken
COM Port settings incorrect

Clock setting incorrect

Reconnect leads
Setup COM port correctly

Synchronise clock with PC. If this does
not work then the Monitor clock battery
may be flat. Return monitor to Aeroqual
for battery replacement.
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Sensor Failure
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The handheld monitors have inbuilt diagnostics to detect sensor faults. If the sensor fails it can be

easily replaced by simply removing and installing a new one. The failed sensor can be sent back to

Aeroqual for refurbishment or disposal. Monitor status conditions are as follows:

0-5Vv Control Low Alarm :Il:ﬂlr"n Data
Fault Output Output Output Logging
Description | -CDScreen | o308 | (S3008 | (S300 & 8‘;5%“; (S500
S500 only) | S500 only) | S500 only) $500 only) only)
Reading
Valid gas proportional | As set by As set by As set by Valid gad
No Fault ; )
reading to gas user user user reading
reading
Sensguli‘taned Sensor failure 5V Open Closed Closed 9999
. Reading
Sensor Aging ;g'dcgngai proportional | As set by As set by As set by Valid gad
Fault 9° to gas user user user reading
sensor aging reading
SENSOR
NOT
- CONNECTED
Comr;:im?:tlons or N.C. or ov Open Open Open No output
turn off when
use Ni-MH
battery only
Standby
Sensor Standby symbol ov Open Open Open No output
8.2. Technical Support
Technical information, service and spare parts are available through your distributor. In addition,
worldwide technical support is available from Aeroqual Ltd.
Please contact:
Aeroqual Limited
109 Valley Road, Mt Eden, Auckland 1024, New Zealand
Phone: +64 9 623 3013
Fax: +64 9 623 3012
Email: technical@aeroqual.com
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9. Guidelines on How to Measure Ozone

The following information is presented to help users operate their Aeroqual monitor with an ozone

sensor installed in the most effective and efficient manner.

General
o Ozone is heavier than air and tends to sink. Thus detection of leaks from ozone generating
equipment should be performed at the most appropriate position.
. Ozone will react and decompose on surfaces such as walls, furniture etc.
. Smell is not a reliable test for the presence or concentration of ozone as the odour

threshold varies widely between people and is affected by local ambient conditions.

Permanent Controller Placement

o The Aeroqual Ozone Controller has been designed to measure the ambient concentration
of ozone. The controller must not be placed directly in an ozone stream.

. For indoor local area monitoring attach the controller to an inert surface with the inlet
unobstructed.

. For leak detection mount the unit near the ozone equipment.

. Ensure that the controller is protected from excessive water splashing, dust, vibration,

excessive heat or cold, high concentrations of ozone and excessive swings in humidity.

False Readings
o The Aeroqual Ozone Controller has been designed to respond selectively to ozone.
However, other oxidizing gases such as chlorine and nitrogen dioxide can generate false
readings if they are at high concentrations. High concentrations of hydrocarbon gases
such as vapours of alcohol, oils and solvents can reduce and mask the concentration of

ozone.

10. Care and Maintenance

Your Aeroqual Monitor is a product of superior design and quality and should be treated with care.

When using your Aeroqual Monitor:

e Keep it and all its parts and accessories out of the reach of small children.

o Keep it dry. Avoid water and/or condensation as humidity and liquids may damage sensitive
electronics and the Li battery.

e Do not use or store in dusty, dirty areas.

¢ Do not store the monitor in temperatures below 10°C or above 35°C.

e This unit is designed for use at temperatures between -5°C and +45°C however please consult
recommended operating temperature for the sensor head which may be different. Avoid sudden
changes in temperature which may cause condensation that can damage the electronics.
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¢ Do not attempt to open. Non-expert handling of the device may cause damage.
e Do not drop, knock or shake as this could lead to internal damage.

¢ Do not use harsh chemicals, cleaning solvents or strong detergents for cleaning. Wipe with a soft
cloth slightly dampened with a mild soap-and-water solution

In order to maintain measurement accuracy, Aeroqual recommends that user replace or
refurbish their sensor heads on a yearly basis or more often if measurement certainty is
critical for your application. Please contact your dealer or Aeroqual.

10.1. Disposal / Recycling

Please note that this is an electronic product and disposal should be in line with your local or country
legislation. The plastic casing of the product is made from a Polycarbonate / ABS blended material
(PC + ABS) and is marked accordingly.
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11. Appendix

11.1. Copyright

Copyright Aeroqual Limited. All rights reserved. Reproduction, transfer, distribution or storage of part
or all of the contents of this document in any form without the prior written permission of Aeroqual
Limited is prohibited.

“Aeroqual”’ and “Aeroqual Limited — Making the Invisible Visible” are registered trademarks of
Aeroqual Limited. Other product and company names mentioned herein may also be trademarks or

trade names.

Aeroqual operates a policy of continuous development. Aeroqual re-serves the right to make changes
and improvements to any of the products described in this document without prior notice.

Under no circumstances shall Aeroqual be responsible for any loss of data or income or any special,

incidental, consequential or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no
warranties of any kind, either express or implied, including, but not limited to, the implied warranties of
merchantability and fitness for a particular purpose, are made in relation to the accuracy, reliability or

contents of this document.

Aeroqual reserves the right to revise this document or withdraw it at any time without prior notice. The
availability of particular products may vary by region. Please check with the Aeroqual dealer nearest

to you.
11.2. Software License

The Series 500 monitor comes supplied with Aeroqual data logging software. Aeroqual will retain
ownership of all intellectual property in the Software. The buyer acknowledges that they are granted a
perpetual, non-exclusive, non-transferable license for the right to use the Software for the buyer’'s
exclusive use and only in conjunction with Aeroqual Products (Intended use). The buyer will strictly
adhere to the Intended Use of the Software and will not translate, adapt, reverse compile or other-
wise alter the Software. The buyer undertakes not to disclose, assign, sell, rent, lend, sub license or

otherwise transfer the Software.

11.3. Terms and Conditions

This product is warranted according to Aeroqual Ltd’s Terms of Trade. For further warranty
information, please refer to the standard Product Warranty Policy as published on the Aeroqual

website at www.aeroqual.com.
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11.4. Statements of Compliance

1. The Aeroqual Series 200, 300 and 500 Monitors and Remote Adaptor Kit comply with
EN 50082-1:1997

2. The Aeroqual Series 200, 300 and 500 Monitors and Remote Adaptor Kit comply with
EN 50081-1:1992

3. The Aeroqual Series 200, 300 and 500 Monitors and Remote Adaptor Kit comply with
Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) these
devices may not cause harmful interference, and (2) these devices must accept any

interference received, including interference that may cause undesired operation.

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates, uses
and can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the

following measures:

= Reorient or relocate the receiving antenna.

®  Increase the separation between the equipment and receiver.

= Connect the equipment into an outlet on a circuit different from that to which
the receiver is connected.

= Consult the dealer or an experienced radio/TV technician for help.

(€ © Fe
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